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Release Notes for Prolog Converge 9.93

Build Number 9.93.0216

Please read this document for important information on this release.

For the latest information about Meridian Systems software, see our website at http://www.me-
ridiansystems.com.

What's New

In response to our customer's requests, the following new features have been added:

Prolog Converge Web Client

Trimble Connect Files
Trimble Connect has been upgraded to use Trimble Identity (TID) credentials. Because Prolog Converge
does not use TID, you can use your API access key or your Trimble Connect password as the password
for accessing Trimble Connect files. (P 82607)

Existing Trimble Connect users
If you created a Trimble Connect account before the upgrade, do one of the following:

l Use the API access key.
l Reset your previous Trimble Connect password.

New Trimble Connect users
If you created a Trimble Connect account after the upgrade, do one of the following:

l Use the API access key.
l Create a Trimble Connect password.

NOTE:
l If Prolog Converge is configured to not cache your Trimble Connect credentials (so youmay need
to enter your credentials every time), youmay want to use the Trimble Connect password.

l If your Prolog Converge email address and passwordmatch your Trimble Connect credentials, you
are automatically logged in to Trimble Connect, and you do not have to authenticate your cre-
dentials.

For more information on Trimble Connect, see the Prolog ConvergeWebClient User Guide (Records >
Trimble Connect Workflow).

To find your API access key
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1. In Trimble Connect, click your profile picture > Profile, and scroll down to theAPI Access Key sec-
tion.

2. If there is no access key, click Generate.
3. Copy the API access key.

When you enter your Trimble Connect credentials in Prolog Converge, you can paste the API
access key in thePassword field.

IMPORTANT:Do not click Update after you use the API access key with Prolog Converge
because the old one will no longer work.

To reset or create your Trimble Connect password

l On the Forgot your password page, enter the email address used to log in to Trimble Connect, and
then follow the instructions in the "Reset your password" email.

User Creation and Password Changes
PrologManager now has a setting that will lock out the ability to create or edit a user's login credentials
(User name and password). This enables custom solutions to be built for organizations that could enable
Prolog to integrate with Active Directory, LDAP, or other user management standards.(P 81387)

If this setting is enabled, Prolog Converge is affected:

l In theAdministration area, the (Add User) button and theChange button for the password are
unavailable.

l In the View menu, theChange Password command is removed from theAdministrationmodule.

File Management System
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l The entire File Management System has been re-written to HTML5 for better usability and per-
formance. Silverlight or Flash is no longer required to run FMS.(TFS 99001)

l Improved the performance of loading folders in the File Management System. Tests support over
30,000 folders and subfolders. (TFS 107145)

l Improved functionality within the updated File Management System by removing a setting that
forced emulation of IE9 for all IE browsers. (TFS 107145)

Locked Records
There is now a new ability to prevent deletion of records by simply locking that record. (P80767)

Closed Potential Change Orders (PCO)
When linking a PCO to a ChangeOrder Request, closed PCOs no longer appear in the Potential CO
Search list. Only 'Active' PCOs are available to be linked to the COR. (P81059)

Files Column in the Daily Work Journal
In Daily Work Journal records, you can link and view files on theManpower/Labor and Equipment tabs. (P
81037)

Files Column in the Material Package
In theMaterial Package, there is now a 'Files' column showing the number of files linked to each of the
Material records in this Material Package. If there are several Material records, each with one or more
linked files, there is now an option to "Get Files" that will download them all to a single zipped file. (P 81060)
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List Views
l Dynamic Form nomenclature is now supported in List Captions. It's no longer necessary to create
duplicate Converge views in order to get the correct nomenclature to be displayed for the set of
users that are currently using them. A keyword will now be recognized in the list view and will be
replaced at runtime with the form nomenclature for the project or database the user is connected to.
For example, instead of “My Outstanding RFIs”, using “My Outstanding [[TableNomenclature]]s”
would produce “My Outstanding SORs” if the nomenclature for RFI in the current project was SOR.
(TFS 106955)

l Views will now run even if one or more columns don't exist in the source database (which is fairly
common for User-Defined Fields that may be specific to certain databases) and for columns that a
user may not have access to (in which case the columnwill be ignored). This makes it easier to cre-
ate general Converge views that can be used across all projects and all users. (TFS 106956)

Budget Code Search Screen
To help you select the correct budget code for Contracts, POs, and PCOs, the following columns were
added to the Budget Code Search window: (P 81038)

l Uncommitted Cost
l Committed Cost
l Projected Cost

Request for Information
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You can now create and save a new RFI without giving it an RFI number when Auto-Numbering is turned
off for RFIs. This option provides, for example, the ability for a subcontractor to create an RFI (maybe
providing their Author RFI #, but NOT a project RFI #). When the general contractor (GC) is automatically
notified that an RFI has been created, the RFI can be reviewed. If deemed appropriate, the GC can assign
an RFI # and forward it to the Architect, thus ensuring that the architect receives RFIs with proper number
sequencing. TheGC may also decide to answer the RFI directly, or reject it, in which case they may return
it back to the subcontractor with only the Author RFI#. (P 82145)

File Management System
As emails are captured in Prolog's File Management System, they are consolidated into a single folder
instead of into individual folders that corresponded to the sender of each email. This helps reduce the num-
ber of subfolders andmakes emails easier to find in the File Management System. (P 82144)

Reports
The following system reports were added:

l Checklists (Detailed, Grouped by Each Number)
l Checklists (Summary Log)
l Material Packages (Detailed, Grouped by EachMaterial Package ID)
l Material Packages (Summary Log)
l Material Tracking (Detailed, Grouped by EachMaterial ID)
l Material Tracking (Summary Log)
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Prolog Web Services
The following web servicemethods were added for creating folders in File Management Service. This
expands the capabilities for creating custom integrations with other File/Document Management Systems
(e.g., Box, Dropbox, SharePoint, etc.) (P 81575)

l FileService.RenameFolder - renames an existing FMS folder

l FileService.DeleteFolder - deletes an existing FMS folder

l FileService.CreateFolder - creates a new FMS folder
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Prolog Converge Admin Tool

Email Processing
For customers that use Prolog's Email Capture feature (either with Form Processing or without), an email
response is now generated and sent back to the initiating user telling them if the were any problems receiv-
ing the email (or processing the form). Previously this information was only available by looking into the
Event Log (which was an Admin-only function). (TFS 106957)

Notifications
When defining Notifications and Lists in Prolog Converge Admin, the options available on the Project tab
havemodified to allow you to indicate whether an item is never to be used in any project in that database.
(TFS 106954 / P 76034)

The ability to specify the databases and projects for a User-Triggered and System-Triggered (also known
as "Workflow-Triggered) Notifications has been added. This functionality already existed for Data-Mon-
itored Notifications. (TFS 106953)
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New Settings in Config Files for Trace Files
The following optional entries are now available in the config files (in the CommonConfiguration area.
These entries will enable you to set amaximum file size and total number of logs for the server monitor and
business layer trace files. (TFS 106949)
<!-- The maximum size of the trace file in MB. The default is 20. -->

<add key="FileTracing.MaxLengthMB" value="20"/>

<!-- The maximum number of historical trace files to keep. The default is
4, the maximum is 100. -->

<add key="FileTracing.MaxFiles" value="4"/>

The updated config files include: 

l ...//Business Layer/web.config

l ...//Mobile Service/web.config

l ...//Servers/ServerMonitor.exe.config

l ...//Web Client/web.config

l ..//Web Services/web.config
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Resolved Issues in Prolog Converge 9.93

The following issues have been resolved:

Number Feature Description

79613 Web Services Modified Prolog's Web Services API to allow a blank character as a Budget
Code separator.

80686 Document
Management
System

Fixed an issue that occurred when reports were generated from a record
with attached files. Sometimes the file name was placed in the middle of
the page instead of at the top.

80726 Notifications Fixed the "Drawing Package - Action Changed" notification that was
duplicating the body of the email for each Package Reviewer listed on the
"Package Reviewers" tab.

ATTN: Prolog Converge Administrators who have modified the C1 report
associated with this notification. It is recommended that you export your
customer C1 report prior to upgrading. After the upgrade, re-import the
customC1 report. Then, change the Tag on your customC1 report from
'dpr.DwgPackageID = [DwgPackageID]' to 'dpr.DwgPack-
RoutingID = [DwgPackRoutingID]'

80907 Document
Management
System

Fixed a rare issue where it was not possible to delete a folder that had
meta data for a file, but the file itself no longer existed.

80978 Admin Tool It's now possible in Converge to create Projects with the same name
without generating an error.

81230 Project Details Added a new view under the Project Overview Section that provides
access to the Project Details without having to leave the project and go to
the Portfolio area.

81330 Prolog Con-
verge

Resolved an issue where user-triggered notifications were not sent with
the correct recipients, project names, and numbers. This occurred when
the ServerMonitor was restarted before all notifications could be pro-
cessed.

81352 Meeting
Minutes

In Chrome, the English (Australia) language setting no longer causes dis-
play problems in Meeting Minute records. The grid and all tabs are now
displayed.

81382 Notifications Fixed an OutOfMemoryException issue that caused the Server Monitor to
crash several times a day.
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Number Feature Description

81394 Potential
Change
Orders

Fixed an issue ("The budget record 0 could not be found in the database")
that occurred when the TPO setting for "Set Budget Code Required PCO"
was set to 'Yes', and a default budget code was defined for PCO items in a
database that was upgraded from 9.8 to 9.9.

81431 Document
Management

In some instances, linking files to multiple Projects in succession during a
single Prolog session (e.g. link FileA to the Project1; link FileB to the Pro-
ject2; link FileC to the Project3, etc.) could create an issue of the file not
being successfully linked in 1 or more of the projects. This has been fixed.

81499 User Interface Resolved a Javascript error that appeared when clicking on a breadcrumb
in IE 11.

81508 Document
Management
System

Fixed an issue in Prolog Converge 9.91 for SharePoint DMS integration
files. An error no longer occurs when the Links tab is clicked in the Files
Properties dialog.

81509 Document
Management
System

In Prolog Converge 9.91, "Copy File Link" is now supported when
SharePoint DMS integration is enabled.

81554 Create Project The default template file, 807780.tpl, was modified to enable a Lookup to
be imported even if some of the attributes for that Lookup had 'zero
length' ("Allow Zero Length" was set to True for the OldValue field in the
tbl_AttrLogs table). Prior to this fix, importing Archives would leave the
Lookups blank after import (generating "Error[-2147220503]").

81605 Reports The Report Designer in Converge has been modified to recognize the fil-
ters and sort orders that are built into a Crystal Report.

81671 Daily Details When Internet Explorer 11, Chrome, or Firefox uses the UK date format,
the values now appear in the time field of the Daily Details records.

81841 Document
Management
System

Fixed an issue where the Document Management System failed to open
when the language in Chrome was set to English (United Kingdom).

81957 BCF Viewer Resolved a Silverlight compatibility issue that prevented BCFzip files from
opening properly.

81981 Admin tool In certain situations, when switching to a view that had the 'Is Template'
option enabled (in Prolog Converge Admin tool > Views), the user could
not log back in to Prolog Converge. This issue has been resolved.

82061 Workflow Fixed a Javascript error that appeared when viewing 'Visual Workflow' in
Firefox.

82062 Workflow Fixed a Javascript error that appeared when doing a 'Record Link' in Fire-
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Number Feature Description

fox.

82093 DCR In rare instances, it could take 10 minutes to save a Daily Field Report. This
has been fixed.

82100 Company
Setup

Fixed a problemwhen viewing companies by classification, e.g. WBE, MBE,
DBE, etc.

82142 Views Fixed a minor issue with the display of the "Companies by Classification"
view.

82144 User Interface As emails are captured in Prolog's File Management System, they are con-
solidated into a single folder instead of into individual folders that cor-
responded to the sender of each email. This helps reduce the number of
subfolders and makes emails easier to find in the File Management Sys-
tem.

82158 /
82220

Reports Fixed a minor issue with a few Meeting Minute Reports where the report
title that was displayed on the screen showed hash symbols &#39. This
issue did not affect actual report output in any way.

82325 Reports Custom reports now run properly in Prolog Converge.

82519 Views Changed the default project view to "Project Summary" instead of "Project
Dashboard" to improve overall performance and usability when logging
into a project.

To change your default view, do the following:

1. Log in to Prolog Converge Admin.

2. Open Web > Control.

2. For 'Full Access Users', change the 'Default Project View'.

Example: To set the Project Dashboard as your default view, select 'Web
Project Dashboard (Project Dashboard)'.
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Number Feature Description

82827 Document
Management
System

Resolved an issue where users could not upload documents to FMS using
IE 10.

106946 
(TFS)

Workflow The workflow approval process was not working properly.

Known Issues

Google Chrome 45 (and higher)
OnSeptember 1st, Google released version 45 of their Chrome browser toWindows platforms. Chrome 45
entirely removed support for plugins like Java, Silverlight, and others (the “Enable NPAPI flag” no longer
exists).

Because Prolog Converge has several components that were built on Silverlight technology, these com-
ponents will no longer work with Chrome 45 or later. When you attempt to run these Converge components
in Chrome, youmay now see errors saying “This plug-in is not supported.”
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The following Converge components are based on Silverlight technology and will not work with Chrome 45
or later:

l Batch UpdateWizard

l WordMerge

l Visual Workflow View (note, workflow itself still functions as expected, andWorkflows can still be
created/viewed/modified in the Grid View)

l BCF Viewer

To use these Silverlight-based components, youmust a supported browser, such as Internet Explorer or
Mozilla Firefox.

Microsoft Edge
Due to some unresolved compatibility issues, theMicrosoft Edge browser is not yet supported. Trimble is
working on providing support for Microsoft Edge in an upcoming release, but in themeantime, all other sup-
ported browsers (IE, Chrome, Firefox) can be used on aWindows 10machine.

Install
Prolog Converge failed to install properly in aWindows 2003 64-bit machine. To work around this issue,
set IIS 6 to enable 32-bit applications. (74725)

Important: This will affect any 64-bit web application currently installed on themachine.

To set IIS to enable 32-bit applications

1. Open a command prompt as an Administrative user.

2. Locate the%systemdrive%\Inetpub\AdminScripts folder (usually C:\Inetpub\AdminScripts)

3. Run the command cscript.exe adsutil.vbs.

4. Set W3SVC/AppPools/Enable32BitAppOnWin64 to 'true'.

For more information, see: http://www.-
microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/405f5bb5-87a3-43d2-8138-54b75d-
b73aa1.mspx?mfr=true
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FMS
When subscribing / unsubscribing a folder with an extremely large number of sub folders, it may take sev-
eral minutes to complete the action.

Dashboard
Dashboard Data Source

When defining the Columns of a Dashboard Data Source page type, do not select the following invalid
columns: "ok_xxx", "PExxx", and "UDFData".

Word Export

Youmay encounter an error when attempting export your dashboard into aWord document. Exporting to a
Word document is only available for sub-reports (drilled-down reports),

Word Merge
Editing a Document

When editing aWordMerge document, youmay be prompted by Microsoft Silverlight to allow Prolog Con-
verge to access your clipboard. Select the 'Remembermy answer' check box and click Yes.

Printing a PDF

When printing aWordMerge PDF using an Adobe PDF print driver, the PDF does not appear with the
proper page size. To resolve this, print a PDF using a different PDF driver. (75146)

Templates

When using a custom template to create aWordmerge document, some formatting issues may occur. To
resolve them, youmust apply the following changes to the template within PrologManager:

Formatting Issue Do this:

The image does not appear in a merged doc-
ument.

Ensure that the image is in a JPEG format. Then,
re-insert the image into the template (Insert >
Picture).

The check boxes are missing. Delete the existing check box and insert it as a
symbol. You can increase the size of the check
box by selecting it and increasing the font size.

Horizontal lines are missing. Delete the existing horizontal line and manually
insert a sequence of underscores "_" to recreate
a line. Do not press ENTER after entering the
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Formatting Issue Do this:

underscores or Word will automatically create a
horizontal line.

The text boxes are missing. Delete the text box and replace it with a table.

The date format does not appear properly. Select the date merge field. On the Word Pro-
cessor menu in Prolog Manager > Format >
Format Merge Field. Select either a Long Date or
a Short Date.

The address does not appear in the correct order. Replace the Addresses.DisplayAddress merge
field, with the following set of merge fields:

{Addresses.Address1}

{Addresses.Address2}

{Addresses.Address3}

{Addresses.City}, {Addresses.State}
{Addresses.Zip}

BCF (BIM Collaboration Format) Viewer
A BCF file cannot be viewed directly from the record to which it is linked. To view the BCF file, locate it in
the File Management System (Project Files > View Files) and then click View.

Grids
If an error is encountered while editing a record with a grid, the 'Error' column disappears after expanding
the columnwidth and height to show the entire error message. To resolve this issue, click and drag the
column to expand themessage again.
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Trimble GC/CM Division, Support Services

Trimble GC/CM Division Support Services is committed to offering timely, thorough, and efficient res-
olutions to your installation and operation issues in accordance with your Trimble Support Contract. 

Our Technical staff is available to you during normal service hours of 05:00 to 17:00 PSTMonday through
Friday, excluding holidays. To receive the best support possible, be sure to review the Trimble Support Ser-
vices Handbook.

You can contact Trimble GC/CM Division, Support Services by:

l Telephone:

l US & Canada: (800) 565-9490

l International: (916) 294-2100

l Fax: (916) 294-2001

l Email: prologsupport@trimble.com

l Internet: http://support.meridiansystems.com

The Trimble SupportLink includes a technical knowledge base, answers to frequently asked questions,
technical documentation, and a form to submit specific support requests 24 hours a day, 365 days a year.
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